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Introduction 
 

Keytime Accounts Production creates a set of final accounts from a trial balance.  Data 

for the trial balance is captured either in journals, entered directly on to the trial balance 

as adjustments or imported from third party applications.     

Accounts Production data can be transferred between the various Keytime modules, for 

example, from Accounts Production into the self employed or partnership pages of the Tax 

module or into the Trading and Professional Profits Calculator of the Corporation Tax 

module.  Data can be imported via a mapping system, directly from some accounting 

systems, or via a ‘CSV’ file (see section Importing and Transferring Data between Accounts 

Production and other Keytime Modules). 

Welcome to Accounts Production 
 

When you first install the Accountants’ Suite only Demonstration records appear in the 

Suite modules.  You can add clients to Accounts Production either by adding them to 

Client Manager, and adding an Accounts Production job (see the Practice Manager user 

manual for further details) or by creating them directly in Accounts Production; Practice 

Manager will detect the new record in Accounts Production and add the client and job the 

next time you open Practice Manager.  

 

Navigating Accounts Production 
 

Accounts Production has the same look and feel as other modules in the Keytime range.  

Navigation tools consist of the main toolbar, drop down menus and the navigation pane. 

Main Tool Bar 

 

The main tool bar looks like this: 

 

 

 

New - Takes you out of the existing set of accounts and creates a new set of accounts. 

Open - Takes you out of the existing set of accounts and back to the open (existing) 

accounts window. 

Maintain - Takes you to the Accounts Production Management screens, you maintain 

client details, contacts, and officers in these screens. 
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Import - Import data from third party bookkeeping packages or csv files. 

Export  - Send final accounts data to Keytime tax modules. 

Help - Launches the on-line help file. 

Submit – Submit accounts to Companies House. 

Exit - Closes the application.  

 

The Menu Bar  

 

The main menu bar has the following options: 

 

 

 

File: Options for creating, opening, deleting accounts.  Options for backing up and 

restoring data can also be found here. 

Edit: Company launches the Accounts Production Management screen (Maintain).  

Contains options for maintenance of client details, contacts, accountant/auditor reports, 

directors details and directors report. 

Status: Options to mark the progress of the accounts. 

Report Formatting: Options to change font, draft message, header positioning and 

various other report formatting options. 

Options: Review, Year end, PDF save location, import mappings and various configuration 

options can be found in this menu. 

Reports:  Various reports can be found in this menu. 

Help: Launches the on-line help file, version details, Keytime website and licence 

information. 

 

The Navigation Pane 

 

The Navigation Pane appears down the left of the main window and looks like this: 
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You can use the buttons on the minor toolbar located at the top of the tree to mark the 

progress of the accounts. 

Use the options in the navigation pane to post journals, view the trial balance, maintain 

notes, make adjustments to the trial balance and post prior year adjustments (adjust 

balances), preview and/or print the accounts and create the accounts as a PDF or iXBRL 

file. 

 

Creating a new Client and Set of Accounts 
 

You would normally create clients and add jobs in Practice Manager, this makes the job 

available in the modules and ensures clients and jobs in the modules are correctly linked 

You can create a new client in Accounts Production by clicking Create in the Open Accounts 

screen, select sole trader, partnership, LLP or small limited company. 

• If you wish to import the trial balance click the Import box (see section Importing and 

Transferring Data). 

• Enter a client account reference, to link this client record back to an existing client 

record in Client Manager, click the Link to Practice Manager button to the right of the 

Client ID field. 

• Enter the company/business/partnership name and address details.  If you are working 

with a limited company, enter the company registration number and registered 

address. 

• If you are working with a limited company and the accounts are audited, check the 

Audited box to replace the Accountants report with the Auditors report.  Enter the 

company registration number and where the company is registered from the drop down 

list. 

• Enter the start and end date of the financial period.  
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• Set the company dormant / company trading options. 

• If the company is limited by guarantee change the option to Guarantee in the Company 

limited by drop down. 

• If the company qualifies as a micro entity and you wish to take advantage of the 

micro entity reporting exemptions select Yes from the Micro Entity drop down box. 

• Click the Page Selection tab and select the pages required in the accounts.  

• Click Save, if you haven’t already linked this record to a client record in Practice 

Manager, you will be prompted to create the client in Practice Manager at this point, 

click Yes to create a client record in Practice Manager (if you click No you can import 

the client into Practice Manager at a later date).  

• Additional tabs will appear in this screen.  If you are working with a limited company 

or LLP, these will be: 

 

 Contacts 

 Officers 

 Accountant (or Auditor) 

 Accounts 

  

If you are working with a sole trader, the tabs will be: 

Contacts 

Accountant (if you have opted for an Accountants Report/Client Approval 

Certificate) 

Accounts 

• If you are working with a partnership, the tabs will be: 

 

Contacts 

Accountants (if you have opted for an Accountants Report/Client Approval 

Certificate) 

Accounts 

Partners 

Maintaining a Set of Accounts 
 

Once you have created a set of accounts and clicked Save, additional tabs are presented 

as below: 
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Maintaining Share Capital (FRSSE Only) 

 

Share capital for a limited company is maintained in the Maintain screen, Client tab 

(disabled if the company is limited by guarantee).  Click the Share Capital button (to the 

bottom left of the accounting period end date).  The following screen is presented: 

 

You can maintain up to 5 share classes, you name the share in the Share Class field for 

each of the share types, this year and last (if applicable).  If this is the first year of 

trading click the Company’s first year box on the top right. 
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• Select the share type (equity or non equity) 

• Enter the nominal value per share 

• Enter the number of shares authorised and number of shares allotted 

• Enter number of shares issued in the year and the total consideration received (if 

applicable) 

• Enter the last year’s detail in the Previous tab 

 

You no longer need to state the number of authorised shares in the share capital note; 

however, you can choose to do so by clicking the Display Authorised Shares box.  

It is important to note that the share capital note is derived entirely from the details in 

the share capital maintenance screen, to ensure accuracy you must check the ledger 

balances in the share capital accounts match the detail in this screen.  

If the Company Secretarial module is in use, share capital can be maintained via the link 

with the company record in Company Secretarial (see below). 

Note that FRS 102 Section 1A does not require share capital to be disclosed, therefore, 

FRS 102 sets of accounts do not contain the share capital option. 

XBRL Tagging Share Capital 

 

Since April 2011, accounts for periods ending 1 April 2010 and later that form part of a 

Corporation Tax return must be submitted to HMRC in iXBRL format.   Accounts 

Production will automatically apply the vast majority of tags for you, but since you have 

full control over how share classes are defined, it is necessary to manually tag share 

classes.  Proceed as follows:  In the Maintain screen, Client tab, click the Share Capital 

button.  Below each of the share class description boxes there is a field for the iXBRL 

tag, click the zoom icon to the right of the tag field, a tree is presented, split into 2 

sections.  Expand either section by clicking the + sign and select a share class, click 

Save once you have selected your tag and do the same with all other share classes. 
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Once you are finished with the share class tags, click Save and Close to return to the 

main Client screen. 

Share Capital and Company Secretarial 

 

If the Company Secretarial module is in use and the company record has a company 

secretarial job assigned to it you have a choice about how to maintain share capital.  You 

can link the share capital to the record in Company Secretarial.  If you do this, the share 

capital is maintained in the record in Company Secretarial and not in Accounts 

Production.   

 

You must first ensure that share capital exists on the record in Company Secretarial; the 

share capital from the record in Accounts Production cannot be imported into the 

Company Secretarial record. 

 

To link the records proceed as follows: 

 

• Open the company record, click Maintain on the main toolbar, click the Share 

Capital button in the Client tab 

• Click the Company Secretarial button on the bottom left of the share capital 

screen 

 

Note that FRS 102 Section 1A does not require share capital to be disclosed, 

therefore, FRS 102 sets of accounts do not contain the share capital option. 

 

Adding, Deleting, Editing Contacts 

 

If you have added company records to Practice Manager, and you have added the officers 

as associated links, the directors will already be present in Accounts Production. 

You can maintain officers in Accounts Production, but these will not be reflected in Practice 

Manager. To add further contacts, or to edit a contact click the Contacts tab and proceed 

as follows: 

• Click a relevant sub tab and click Maintain Contacts 

• To add a contact, click Add Contact; alternatively click Edit to edit existing contacts 

or Delete to delete a contact. 

• If you are adding a contact, enter contact details.  Click Finish. 

• To add the contact to this set of accounts, click the contact name in the global list 

and click the arrow pointing right to move the contact to the contact list for this set 

of accounts.  Click Save 

• Click the Overview button to see a list of contacts and their type in this set of 

accounts. 

 

Presentation of Accountant or Auditor 

 

Contact store details for the Accountant or Auditor contain some presentation options for 

the accounts.  You can: 
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• Include the name of the accountant or senior statutory auditor in the information 

page. 

• Select ICAEW, ACCA or ICAS recommended wording for the accountant’s or 

auditor’s report. 

• Resolve the presentation of the singular/plural possessive noun by ticking/un-

ticking Firm of Accountants.  

 

 

Maintaining Directors Details and the Directors’ Report 

 

Click the Officers tab, the following screen is presented: 

 

In Directors Information you will see the directors added in Practice Manager or in the 

Contacts tab. 

• Click the add/maintain directors button to add more directors or remove or edit 

existing directors.  Note that officers added to the company record in Practice 

Manager will be added to the record in Accounts Production, but it is possible to 

add officer records if Practice Manager is not in use. 

• Click the first director and enter the date appointed (if within the year being 

reported), date ceased (if within year being reported). 

• Click subsequent directors and enter their details.  

• You can include directors that have resigned outside of the financial year being 

reported by clicking the director’s name and then tick Override director names and 

select Yes to include on the company information and directors’ report as required.  

 

 

Maintaining Partners (Partnership Accounts Only) 

 

You maintain Partners details in the Contacts tab.  Appropriation of partnership profits is 

maintained in the Partners tab of the Accounts Production Management screen.  In 

addition, each partner is allocated a range of ledger codes, which can be seen in the grid 

in the partner’s tab. 
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Click the Partners tab, you will see partners details displayed in grid form.  Enter the 

percentage profit share and any salary that you wish to allocate.  Salary is allocated 

initially, with the remaining profit being apportioning to the partners in the profit sharing 

ratio.  Partnership accounts include an appropriation account, which is produced after 

the profit & loss account. 

You can select the partner(s) who will sign the approval certificate by ticking the 

nominated partners in the ‘Partners who sign’ list in the bottom right of this screen. 

Joint Partners 

 

You can join partners together, for example, where you have two individuals in business 

but the profits aren’t apportioned in the accounts.  The individuals are named separately 

for the purposes of signing the accounts, but they share capital and current accounts.  

To join partners together proceed as follows: 

 

• In the partnership accounts, click Maintain / Contacts / Partners 

• Add the individuals as required if they do not exist already; add them to the list 

of partners 

• Click the button at the bottom of the list of partners to link the partners: 

 

  
 

• Click the Link partners box 

• Enter a name for the linked partners (this will appear on the capital and current 

accounts): 
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• In the list of partners click the first individual to link, click the green arrow 

(pointing right) to add the individual to the joint list.  Do the same with the 

second partner (as in the screen shot above) 

• Click the link button to complete the linking 

• Click Save, click close 

 

To de-link joint partners: 

 

• Click Maintain / Contacts / Partners 

• Click the link partners button 

• Click the joint partners to de-link, click the joint partners to de-link   

• Click the de-link button: 

 

 
 

• Click Save, click close 

 

To edit joint partners name 

 

• Click Maintain / Contacts / Partners 

• Click the link partners button 

• Click link partners 

• Click the joint partners in the list of partners 

• Click the edit button to the right of the joint partners name field: 
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• Click save, click close 

 

 

Positioning the Client Approval Certificate (Sole Traders and Partnerships) 

 

You can optionally include an Accountants’ report with sole trader and partnership 

accounts; click Maintain, Page Selection and click Accountants’ Report to include the 

report.   

The Client Approval Certificate for sole traders and partnership accounts can be positioned 

either on the bottom of the Accountants’ Report or the bottom of the balance sheet.  The 

wording may be changed (see Maintaining Notes and Reports section). 

Whether you choose to include the Accountants Report of not, the Accountants tab will 

be displayed in sole trader and partnership accounts click the Accountants tab and 

choose where the client approval certificate is to be presented. 

 

Maintaining the Chart of Accounts 

 

Click the Accounts tab, the chart of accounts is presented: 
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Searching and Filtering Accounts 

 

You can filter accounts by group; you can search for accounts by code or by any string of 

text in the description.  You can filter accounts at group level one and/or group level 2, 

for example, apply a filter at group level one Administrative Expenses, apply a filter at 

group level 2 Staff Costs; you will be presented with all accounts in that group.  You can 

filter favourite accounts by checking the View Favourites box whenever you open a search 

screen or account code list. 

To search for an account by code or description, click in the Search field and type either 

the code or a string of text, as soon as you start to type a list of codes will be presented 

that contains either the code or the text.  For example, you may be searching for internet 

costs, type internet in the search box and the system will present all accounts that contain 

the word internet.  Note that the description does not have to begin with the text you are 

searching for. 

 

Adding Account Codes 

 

Additional account codes may be added; they are based on existing account codes and are 

called Sub Codes.  Sub codes mirror the behaviour of the main (existing) code in reports, 

notes and the integration with the Tax modules.  For example, if you wish to create an 

additional sales account code, you create a sub code based on the main sales account 

code and the sub will behave in exactly the same way as the main code. 

To create a sub code, proceed as follows: 

• Click Maintain on the main toolbar, click the Accounts tab. 

• Click on the main account you wish the sub account to be based on and click the 

Add Codes button, the following screen is presented: 

 

 

• Enter a description for the sub code and click Save.  You will see the code has been 

added to the chart of accounts and it appears directly below the account code it is 

based on, it has the same main account number and a sub account code in the Sub 

field: 
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It is important to note that sub accounts mirror main accounts in every way.  If for 

example, you create a sub code based on Entertainment and call it Entertaining 

Disallowable, the sub code will behave in the same way as the main account, that is to 

say the balance will not automatically be treated as a disallowable expense when updating 

the tax return. 

 

Renaming Accounts 

 

You can rename an account by clicking the account code and clicking the Rename Code 

button.  Note that you may only rename an account; you cannot change the way in which 

it behaves or the location it appears in the reports. 

 

Favourite Account Codes 

 

Accounts Production allows you to nominate favourite or often used account codes.  

Favourites can be set system wide or at client level.  To nominate favourites at client level, 

open the Maintain screen, click the Accounts tab and click the Favourite button by the 

account codes you wish to nominate, Yes appears in the Favourite field by a nominated 

account. 

To nominate favourites for the system, click the Edit menu, select System Favourites and 

proceed as above.  To obtain a chart of accounts listing click the Reports menu, select 

either Chart of Accounts to print/preview all accounts or Chart of Accounts (Favourites) to 

print/preview favourites. 

 

Maintaining Notes and Reports 

 

Accounts Production installs with a template set of notes, auditor and accountants’ reports 

and directors’ report.  Wording may be edited or deleted and changes can be saved for a 

specific set of accounts or for all sets of limited company accounts. 

iXBRL requires data within some notes to be tagged, where this is a requirement you will 

see a further icon by the note which presents a window where you can enter ready tagged 

detail for inclusion within the note.  See section below iXBRL tags in text notes for more 

detail. 
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Click Notes on the navigation bar: 

 

Notes and reports are grouped and arranged in a tree, as in the screen shot above.  Click 

the report required or the accounting policies or notes section to reveal the various report 

sections or notes. 

• To edit the Directors’ report, click Directors’ report. 

• To edit the Accountant’s/Auditor report click either Accountant or Auditor group 

(whichever applies). 

• To edit an accounting policy, click the Accounting Policy group (limited company 

only). 

• To edit a note click the Notes group.  The majority of notes are derived from entries 

in the ledger, for example the fixed asset notes.  In this case, the main body text 

of the note will be generated as you run the accounts, any additional text that you 

enter for this type of note will appear as trailing text to the main note.  

 

Notes required by FRS 102 S1A are automatically included, you will find they are ticked 

and note number have been added once you have added figures to the accounts.  Some 

notes are not mandatory, or they are recommended but not mandatory (for example the 

transition to FRS 102 note).  These notes are not automatically included; you must add 

them if you want to include them: 

 

• Add the required note by clicking (tick) the box by the note name. 

• Enter any additional text to appear at the foot of the note into the note space (as 

below) 
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Some notes and accounting policies are made up of text entries only, such as the operating 

profit note and transition to FRS 102.  In this case, enter the note text as above. <Ctrl> 

and <Tab> keys used together will indent the text. 

 

Declarations 

 

You can set up standard pieces of text (declarations) to include in notes and reports.  

These pieces of text are stored centrally and can be used across clients.  You can make a 

standard piece of text default, which the system will add to all new clients.  For example, 

if you have preferred standard wording for a particular accounting policy you can use a 

declaration to override the standard system policy.   

To add a declaration: 

• Click the Zoom button (spy glass) to the top right of the preview text box, click 

Edit/Add. 

• Click Add and enter a description for the note in the Customised Description field. 

• Type your note in the Note window, you can add database fields by browsing the 

Insertable Fields list and double clicking the required field. 

• To save your new note as the default note, click Yes in the Make Default box, 

otherwise click No. 

• Click Save, then click Select and your new note will appear in the preview text box. 

 

You can remove the Make Default setting from your customised note at any time by going 

back to the note and clicking No in the Make Default box then click Save.  Click Select to 

select the original system note. 
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Tangible/Intangible Fixed Assets and Depreciation Rates and Method 

 

The standard category descriptions for tangible and intangible fixed assets can be edited.  

As you activate the relevant accounting policies you will be presented with an additional 

option to edit the category descriptions, and in the case of tangible fixed assets, set the 

depreciation rates and method.  Click the Edit button by the tangible fixed asset policy, 

the following screen is presented: 

  

You can edit the category descriptions in the Headings column, enter the rate of 

depreciation and select the depreciation method.  The ledger codes associated with the 

various categories are displayed; you cannot change the way in which the ledger codes 

are assigned.  The end column allows you to apply iXBRL tags. 

 

iXBRL Tagging Tangible/Intangible Fixed Assets 

 

Accounts Production will automatically apply the vast majority of tags for you, but since 

you have full control over how fixed assets are defined, it is necessary to manually tag 

asset classes.  Proceed as follows:  Click the Report Formatting menu, or click Maintain, 

Accounting Policies Tab, tick the Tangible Fixed Asset policy (or Intangible Fixed Asset 

policy), click the blue button to the right of the policy.  Click the blue button to the right 

of each asset category tag field, the following screen is presented: 

 

    
 

The + sign by an item in the tree indicates that there are further tags as children of that 

tag, for example, the tag Vehicles, Plant & Machinery has 2 further child tags – Plant & 
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Machinery and Vehicles.  The Vehicles tag has further child tags for various types of 

vehicles. 

The items that have a + sign are (parent) tags in their own right; you can use these if it 

is appropriate to do so, for example, you have grouped together a number of vehicle 

types under a heading called Vehicles.   

You cannot use tags more than once; if you feel the need to do so you must batch items 

together. 

To tag an asset category, click on a relevant tag; the tag name and details will appear in 

the boxes at the bottom of the screen.  Click Save to save your changes and close the 

screen.  Repeat the exercise for all other asset categories where these appear in the 

asset notes, for example, if you do not have any land or buildings you do not need to tag 

this category. 

iXBRL Tags in Text Notes 

 

Some notes, such as transactions with related parties, director’s advances and 

guarantees, controlling party require some detail within the note to be tagged.  To help 

you comply with this requirement, screens have been added that contain fields where 

you can capture the detail to be tagged and you then add the pre-tagged fields into your 

text note 

 

 

Transactions with Related Parties 

 

This note consists of text entered in the related parties note screen, detail that is 

required to be tagged should be entered in the note detail window and then dropped into 

position within the text note; the fields within the note detail are already tagged.   

Access this note by clicking Notes on the navigation pane, click Notes, click related party 

transactions and click the note detail button to the top right of the note:  Enter the 

detail as prompted and click Save.   

To use the detail within the text note, click the zoom icon: , click Edit/Add, click Add 

to create a new note and enter a description, you will be prompted to create the new 

note using any wording that has been entered in the system default note, click no.  

There are 2 frames in the note window, use the top frame to build up your note; the 

bottom frame will display the note as it will appear in the accounts.  To the right of the 

note window is a list of database fields that you may include in the note: 
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Click the + by the related party heading to access the data you entered in the note detail 

window.  You insert the database fields at relevant points in the note, to insert a field 

position the cursor in the top frame at the point where the field content is to appear, 

then double click the field in the insertable fields list, the note will appear like this: 

  

To use the note as default in other sets of accounts, tick Yes in the make default option, 

to use the note just for this set of accounts tick No, click Save and then click Select to 

add the note to the accounts. 
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Directors’ Advances and Guarantees 

 

Access the note detail by clicking Notes on the navigation pane, click Notes, click 

Directors’ advances and guarantees.  Click the Note detail button to the top right of the 

note.  The company directors will be listed, click the required director and click Select, 

enter the detail as prompted; the fields are pre-tagged, click Save and Close.  The note 

will appear in columnar format within the accounts. 

 

Controlling Party 

 

The controlling party is added by clicking the note detail button to the far right of the 

note; the field is pre-tagged.  The detail will then appear within the accounts.  

 

Importing Trial Balance Data into Accounts Production 
 

Trial balance data can be imported from various sources.  Accounts Production has ready 

mapped links to popular bookkeeping packages.  All imported data is imported as a 

journal, which is automatically updated into the current year.  The journal can be un-

posted and amended and re-posted as required (see journals section for further details).  

There is no limit on the number of times data can be imported and you can import either 

periodic movement or a cumulative trial balance. 

Generally, data is imported into Accounts Production in the current year; if you wish to 

import previous year’s data you need to start the set of accounts in the earlier year.  For 

example, if the current year is 01/01/2017 – 31/12/2017 and you wish to import last 

year’s data, then start the accounts in 01/01/2016 – 31/12/2016 and import that first.  To 

import data for the next year you must run year end (please go to Year End chapter) to 

roll the year forward so that 01/01/2017 – 31/12/2017 becomes the current year.  

  

Importing Data from Bookkeeping Packages into Accounts Production 

 

Accounts Production can import data from several bookkeeping and other Accounts 

Production packages.  Currently these are:  

• KashFlow 

• Xero 

• Compac 

• PTP/IRIS Accounts Production 
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To import a trial balance from Kashflow or Xero, proceed as follows: 

1. Click Options / Import Credentials / IRIS KashFlow Details or Xero Details, enter 

your KashFlow Connect/Xero agent email address and password 

2. Click Maintain on the main toolbar, in the Client tab click the Import button 

3. In step 1 select KashFlow/Xero as the data source, step 2 auto-populates with 

your KashFlow Connect or Xero agent email address and password.  Enter the 

KashFlow Username for this set of accounts (this is the username of the company 

you want to link to) 

4. Step 4 allows you to review account mappings between KashFlow/Xero and 

Accounts Production.  The accounts are ready mapped to the KashFlow/Xero 

standard ledger code list, note that the mapping may need editing if account 

codes have been changed or edited in KashFlow or Xero (see below) 

5. In step 5 click the Import button to proceed with the import of data from the trail 

balance.  You will be presented with the accounting period to import and an 

option to include opening balances.  The Xero import will prompt you to open a 

session, which runs for 30 mins.  Including opening balances will import the 

cumulative position rather than the movement on the individual accounts 

6. Close the Maintain screen and open Journal Entries in the navigation pane; the 

imported journal will be visible and you can un-post and make changes if you 

wish before re-posting 

7. Once the link between the set of accounts and the KashFlow client has been 

setup, you can click Import on the main toolbar to import data where you will 

only be prompted for the accounting period 

  

Keytime Accounts Production can import a Trial Balance from a range of bookkeeping 

packages and also from CSV files.  Imports from PTP and IRIS Accounts Production are 

done in csv format, the only difference for this type of import is that we have included a 

pre-mapped template to link to csv files output from these products – Select PTP or IRIS 

rather than csv when selecting the data source, an appropriate template will appear in the 

Template field for you to  use.  

To import data from a trial balance in CSV format it may be necessary to review the format 

of the trial balance as Accounts Production requires the data to be in a specific order before 

it can be imported.  Proceed as follows: 

Review your trial balance in Excel (or similar), the file must be in the following layout: 

 

Column A Date 

Column B Ledger Code   

Column c Account description 

Column D Debit balance (as positive amounts) 

Column E Credit balance (as positive amounts) 

Below is a sample screen shot from a trial balance in the correct format in Excel: 
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There must be no header or footer (debit and credit columns must not be totalled, 

although it is a good idea to ensure that the columns agree prior to import)  

There must be no speech marks ( “ ‘ ) or commas ( , ) anywhere in the file 

If you make a change to the file layout, please ensure it is saved in CSV format by 

clicking File, then Save As and selecting CSV (comma delimited) as the file type: 

 

 

Once you have your CSV file created and saved in a known location, open Accounts 

Production and open the set of accounts you wish to import into. 

1. Click the Maintain button on the main toolbar, in the Clients tab click the Import 

button, select csv as the data source  

2. In step 2 click the Brose button and navigate to the location of your csv file 

3. To apply or review code mapping, click the Mapping button.  You can apply a pre-

mapped template by clicking the dropdown in the Template Name field and 

selecting the name of the template (see below for details on how to amend 

template mapping), click Save and Close once you are done with mapping 

4. Click Import to import the data 

 

 

Map the ledger codes proceed as follows: 
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1. In the Import screen, click Mapping 

2. Map codes by selecting the code in the left of the screen and match it off with 

a corresponding code on the right of the screen, click Map; the mapped codes 

will appear in the frame at the bottom of the screen: 

 

 
 

 

 

3. To amend mappings, click the code you wish to amend in the bottom section 

of the screen and click Remove Map (bottom right), you will see that the code 

now appears in the top section of the screen ready for you to map to an 

alternative Keytime code 

4. Clear All Maps will remove all mappings 

5. To save your mapping for future use as a template, enter a template name in 

the new template field and click Save 

6. Once you are finished with mappings click Save and Close   

 

 

Capturing Balances using Journals 
 

Introduction 

The trial balance can be captured by using journals.  Accounts Production features a 

number of journal types, the accruals and prepayments journal type will automatically 

reverse itself at year end if you take the option to bring forward balances.  Journals can 

be automatically balanced; a balancing account is required, the system will then post the 

balancing entry to that account. 
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Post journals as follows: 

Click Journal Entries on the navigation tree, click Add and choose a journal type, note 

that accruals & prepayments type will auto reverse at year end.  The following screen is 

presented: 

 

• You can specify how the description field is to work on each line.  Click the 

description settings button (to the right of the description field).  

• Enter a description for the journal  

• Move to the journal lines and choose a date (the line defaults to today’s date) 

• Enter the account code; you can select the code from a list by pressing Enter in the 

Account Code field or clicking the Zoom icon to the right of the code field.  Use the 

Search and filter options as previously described to locate the required code.  There 

is also the option to add sub codes at this stage. 

• The entry displayed in the description field is dependent upon the configuration 

settings chosen (see above). 

• Debit or credit posting is dependent upon whether the figure is entered in the debit 

or credit column (figures are always entered as positive numbers). 

• To create another line, press the Enter key or click the Add button. 

• Any balance can be seen in the bottom right of the journal screen. The journal can 

be balanced by either adding a balancing entry to the journal lines, or by ticking 

auto balance and applying a balancing account code. 

• Click Post to update the journal, or you can leave it open by clicking Close.  

• You can print a journal report, preview the trial balance, profit & loss, balance sheet 

or detailed PL by clicking the Print button in the Journal Management screen.  

• You can export/import a journal by clicking the Import button to the right of the 

Journal Description field.  You can export once the journal has been posted, and 

you can import when it is in an unposted state.   

 

 

Unposting a Journal 
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Once you have started to capture journals, the details remain in batches in the system.  If 

you haven’t posted a journal you can open it and amend it or add to it, once it has been 

updated the journal may be unposted, amended and posted again.  To unpost a journal: 

 

• Locate the journal in the Journal Management screen, this is the first screen you 

see when you click Journal Entries on the navigation tree.   

• Open the journal by either double clicking it, or click the View button. 

• Click Unpost in the journal screen. 

• If the original journal was auto balanced, the balancing entry in the journal lines 

will be removed as the journal is unposted, but will be recalculated and added in 

again as the journal is posted. 

 

Unpost will reverse the journal entries and allow you to amend and re-post.  To delete a 

journal click the journal in the Journal Management screen and click delete.  This will 

reverse the entries and remove the journal completely. 

Reversing Journals 

 

Accruals & Prepayments journal type will automatically reverse itself after year end if 

you opt to bring forward balances.  A reversing journal will appear in the journal 

management screen at year end.  This journal type works in the same way as all others 

in that it can be unposted and edited or deleted as required. 

 

Out of Balance Accounts and the Suspense Account 

 

The ledger contains a suspense account (account 9999) in the balance sheet, which may 

be used to temporarily balance the accounts where, for example, you have an out of 

balance trial balance taken from the client’s accounts.   

It is important to note that if you post anything to the suspense account, whilst the 

accounts appear to balance, the balance sheet will not; it will be out of balance by the 

balance on the suspense account.  When you generate the accounts, and you have opted 

to run the Warnings report, a message will appear in the warnings report informing you 

of this.  Once generated, the balance sheet will be out of balance and a message will 

appear at the very bottom of the balance sheet stating that there is a balance in the 

suspense account.  You must clear the suspense account to balance the balance sheet.  

 

Printing Journals 

 

To print an individual journal, click Journal Entries on the navigation tree, locate the journal 

and click View.  Click Print.  The report will first be presented on screen, click the print 

button to print the report. 

To print a journal listing, click Journal Entries on the navigation tree, click the Print button, 

click Journal report.  You can filter the Journal Management screen by year; click the drop 

down on the filter by year field and select the year.  The journal listing will then print 

journals for the year selected. 

Individual account detail can also be viewed and printed in the Ledger Transactions 

report.  Access this report by clicking the Reports menu and select Ledger Transactions.  
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You can range by account code; select all accounts, a range or accounts or an individual 

account.  You can include the brought forward balance (where this is present) or left 

unticked view the movement in the year only.  You can view this year or last year’s 

transactions and view journals and adjustments together or only journal entries or only 

adjustments (adjustments come from the Adjust Balances screen, see below for further 

details). 

 

Capturing/Amending Balances using Adjust Balances 

 

You can bypass journals and enter/adjust balances directly on the trial balance.  Adjust 

Balances is ideal for quickly capturing a trial balance either for the previous or current 

year.  It is important to note that the system does not report any adjustments made in 

this manner on the journals report, instead there is a separate report which records 

adjustments to the account balances, and adjustments are also recorded separately in the 

Ledger Transactions report.  The drill down feature also records adjustments separately 

from journal entries. 

On the navigation tree click Adjust Balances, the following screen is presented: 

 

• You can search and filter account codes, you can add sub codes and rename codes 

in this screen. 

• You can adjust balances for the current year or the previous year; click Current or 

Previous tab.  Where a set of accounts is outside of ‘take on’ mode i.e. you have 

run a year end, and you opted to bring forward balances, any adjustments to the 

previous year are brought forward to the current year.  The system identifies this 

type of transaction and will recalculate opening balances in the current year.  

• The profit and loss and balance sheet accounts are split between the Profit and Loss 

and Balance Sheet sub tabs.  

• The Amount field displays the total of all journal entries to an account code.   

• Enter the amount of adjustment in either the Adjustment Debit or Adjustment 

Credit fields.  The resulting balance is displayed in the Total column. 



29 
 

 
0845 456 3103 support.keytime.co.uk 

• Click Commit Adjustments to adjust the balance. 

• Once you start to use Adjust Balances the system will retain adjustments in the 

Adjust Debit and Adjust Credit fields, subsequent adjustments can be made by 

amending the adjustment figure.   

• You can clear any adjustments made by clicking Clear Adjustments; this will clear 

any adjustments you made in this session prior to clicking Commit.  This is useful 

if you made a mistake in the current session and you need to reverse the 

adjustment. 

• Clear All Adjustments will clear ALL figures in the Adjust Debit and Adjust Credit 

columns regardless of whether they are committed or not.  Account balances will 

also be adjusted accordingly. 

• The retained profit or loss is displayed in the bottom centre of the screen.  The 

Balance field shows the difference between the debit and credit columns. 

• It is important to note that if you move off the Adjustments screen after making 

entries and without clicking Commit, your changes will be lost; you can commit 

changes without balancing your adjustments and then revisit the screen to balance 

things up.  You will be warned that the accounts are out of balance. 

 

Drill Down in Reports 

 

You can drill down to underlying journals and adjustments from a set of accounts 

preview.  First, generate the accounts from the Print menu or the Print area in the 

navigation tree.  Once the accounts appear on screen you can drill down on figures in 

the accounts and notes.  You can see journal figures and any adjustments; you can also 

see which accounts make up the balance on the report. 

To drill down, locate the figure in question in the report, point the mouse at the figure (a 

spy glass will appear), double click, point again and a hand will appear, click again and 

the details will appear.  There is a Journal button in the Details screen; you can post 

additional journals from here as necessary. 

Rounding Figures in the Accounts 

 

Figures are presented in the accounts rounded to the nearest £ although the transactions 

and balances may have been captured un-rounded.  The system handles rounding and 

automatically balances the accounts by placing any rounding difference by default in 

account 1463 General Travel Expenses for rounding in the P&L and 5400 Trade Creditors 

for rounding in the balance sheet.  You will not find a transaction in these accounts; the 

system merely uses the accounts to balance the profit and loss and balance sheet. 

You can amend the rounding accounts if you find an odd £1 appearing in the accounts, 

perhaps to an account that has a balance where it wouldn’t be noticeable.  To amend the 

rounding account, click the Options menu, select Configure, click Rounding Account, 

select the account to be used as the rounding account.   

Take on Opening Balances and Comparatives 
 

When you first create a set of accounts, the system is in ‘Take on’ mode.  You capture 

this year balances and last year comparatives independently of each other, that is to 

say, last year comparatives do not have any effect on this year balances; you must post 
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the cumulative trial balance for both years.  Balances may be captured using journals or 

the Adjustment screen. 

Once you run year end on a set of accounts, the system moves out of take on mode and 

you lose the ability to post journals in last year, however, it is possible to re-state the 

comparative figures using the adjustments screen.   

Of course, you may start your accounts in the previous period, take on the comparatives 

as the current period and then run year end if you want the balance sheet closing balances 

to be brought forward. 

 

Review the Trial Balance & Drill Down 

 

You can review balances in the trial balance and optionally drill down into the balance to 

reveal journal entries and adjustments. 

Click Trial Balance on the navigation tree, the following screen is presented: 

 

 

• You can search and filter account codes, you can add sub codes and rename codes 

in this screen. 

• Profit and loss and balance sheet accounts are split between the Profit and Loss 

and Balance Sheet tabs. 

• To drill down into a balance, double click on a balance, the following screen is 

presented: 
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• Journal entries to this account are displayed in the Journals tab, Adjustments to 

the account balance are displayed in the Adjustments tab and the total is displayed 

in the Totals tab. 

• The Journal button is a link to the Journal Management screen, where you can post 

additional journals if necessary. 

 

 

 

 

Viewing and Printing the Accounts 

 

The Print section of the navigation tree has the following options: 

 Print Menu – Launches the following screen: 

 

 

You can: 
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• Select either Full Accounts or s444 (limited company only), select the pages to 

print. 

• Change the font style and size; the font defaults to the system wide font set in 

the Report Formatting menu. 

• Select the column header style, either in the format DD/MM/YYYY or YYYY 

• Set the print to draft and set the draft message. 

• Include or exclude comparatives.  Excluding comparatives will also move the 

current year figures into the comparative position. 

• Select the printer to print out the report to by checking Show printer driver 

options, left unchecked the report will be output to your Windows default printer. 

• Speed a preview by checking the option Do not generate note and page numbers.  

You will need to uncheck this option when generating the final set of accounts. 

• Print the trial balance, journal report, chart of accounts and Warnings report.  

• Output to screen (Preview button), print from screen by clicking the Printer 

button in the report header.   

• Output straight to printer (Print button), click Show printer driver options to 

select the printer. 

• Output to PDF (PDF button), the PDF will be created and can be saved in a 

location of your choice. 

 

These reports can be viewed on screen and printed if required by clicking the Print 

button in the top left of the report when on screen.  The report can also be exported for 

use in a third party application such as Microsoft Excel. 

 

Report Formatting Options 

 

Click the Report Formatting menu, the following options are available: 

 

• Fonts – Set a font size and style for this set of accounts 

• Draft message – Change the draft message 

• Draft – A tick indicates that the accounts will output in draft mode 

• Report header – Bold font style and justification options 

• Column header style – Short or long date format for numeric columns 

• Column header position – Justification options for column headers 

• Custom cover sheet text – Tick option to override standard cover sheet wording  

• Amend cover sheet text – Enter wording for cover sheet (used in conjunction with 

the above option) 

• Detailed P&L options – Page break adds a break after a selected section.  Show 

taxation shows or hides the taxation section on the bottom of the report 

• Fixed asset headings – Amend the tangible fixed asset category headings 

• Intangible fixed asset headings – Amend the intangible fixed asset category 

headings 

 

Output to PDF 

You can specify a save location for the system to use when outputting to PDF.  Click the 

Options menu, select Configure, click Set PDF Save location, browse to a suitable 

location.  If you would like the option of specifying a save location each time you 

generate a PDF tick the box to always select a path when exporting to PDF.  Click Save 

to save changes and exit the screen. 
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Generating Note and Page Numbers 

 

Accounts Production will automatically generate note and page numbers if you click on 

any of the output options in the Print group on the Navigation tree. 

 

S444 Accounts Preview – generates all pages of the abbreviated accounts 

including note and page numbers (limited company only) 

FRS 102 Accounts Preview – generates all pages of the accounts including note 

and page numbers (limited company only) 

Partnership/Sole trader Accounts Preview – generates all pages of the partnership 

or sole trader accounts including page and note numbers (partnerships and sole 

trader only) 

PDF – generates all pages with note and page numbers and outputs to PDF 

 XBRL – generates accounts with XBRL tags 

 

 

Output to XBRL 

 

Output XBRL – Applies iXBRL tags to the accounts and presents accounts in HTML with 

the ability to view tags.  Click Output to XBRL, the accounts will then be presented in 

HTML view with further tabs to view all the tags that have been applied (these cannot be 

changed) and to view the accounts in HTML with the tags highlighted. 

To export the XBRL file in ready to attach to a corporation tax return please see Export 

section below. 

Filing Accounts at Companies House 
 

You can file iXBRL s444 or dormant accounts to Companies House.  Before you can do 

this you must have a credit account in place at Companies House, who will issue a 

presenter ID and an authentication code.  Further details on how to setup a credit 

account and obtain the required codes can be found on the Companies House website: 

http://www.companieshouse.gov.uk/toolsToHelp/efilingfaq.shtml  

To submit accounts, proceed as follows: 

• Click Submit on the main toolbar. 

• Click Add Details and enter your presenter ID, authentication code and an email 

address where you want Companies House to send any correspondence.  If these 

details are to be used for filing this company only click the box to save details for 

this company only.  Enter the company authentication code.  Click Save. 

http://www.companieshouse.gov.uk/toolsToHelp/efilingfaq.shtml
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• Click the Generate button to generate the accounts in iXBRL format.  Note that 

s444 accounts will be generated if the dormant status is set to NO (Click 

Maintain, Client tab). 

• Click the Submit button to begin the process of sending the accounts to 

Companies House. 

• The Details and Company Information tabs will be pre-populated with information 

already in the system, anything missing can be entered at this stage. You can 

preview the accounts being submitted by clicking the Preview button by the file to 

be submitted field in the Company Information tab. 

• In the Company Information tab click Submit. 

• The History tab shows all submissions to Companies House with their current 

status.  When the accounts are initially sent (without error), the status will show 

as Pending, if there was an error in the submission the status will show Error; 

you need to try the submission again if this is the case.   

Important Note 

• Companies House do not automatically issue successful submission responses (as 

do HMRC), once the submission has been made, it will be retrieved and checked 

at Companies House, who will amend the submission status once approved.   

 

Configuring the Companies House Submission Checker 
 

Please note that accepted or rejected submission responses are not returned 

immediately when filing to Companies House; a submission will be flagged as Pending 

until either an accepted or rejected response is returned.   

The Companies House Filing module also consists of a small programme that polls 

Companies House for submission responses.  This programme installs with every 

instance of the filing module and when running appears in the right of your PC task bar.   

Within the Companies House filing Module, after clicking submit, click the red cross on 

the top right to close the filing module, the Filing module checks to see if the Submission 

Checker is running.  If the Checker isn’t running the following screen is presented: 

 

It is recommended that you take the option (ticked by default) to launch the Keytime 

Companies House Checker on Windows start up.  Click the Launch button to start the 

Checker, a small icon:             will appear on the right of your PC taskbar. 
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The icon may initially be hidden, to reveal the icon on the taskbar, click the show hidden 

icons button on the right of the taskbar (appears as a small upwards pointing arrow on 

the right of the taskbar) and select Customise, scroll down to Keytime Companies House 

Checker and amend the notification setting to Show Icon and Notifications.     

To configure the Checker, right click the Checker icon on the taskbar and select Settings, 

the following screen is presented: 

 

You can set the check interval by altering the number of minutes in the Check Every 

option.  Run on System Startup when ticked will launch the Checker automatically 

each time Windows starts (recommended).  Show History shows a submission log and 

the latest submission status; double click a submission to view the stored response.  

Save saves any changes you have made.  Cancel closes the settings screen but leaves 

the Checker running on the taskbar.  Exit App closes the Checker completely. 

 

Receiving Submission Responses from Companies House 

 

In the Companies House Filing module, the History tab shows all submissions to 

Companies House with their current status.  When the accounts are initially sent 

(without error), the status will show as Pending, this means the submission has been 

received by Companies House and is awaiting a response (accepted or rejected) from 

them.  

If there was an error in the submission the status will show Error; you need to resolve 

the error and make the submission again if this is the case.   

 

To manually check for a response, double click the pending submission in the History 

tab.  Otherwise, if the Companies House Submission Checker is running on your taskbar 

the submission will be brought back to the system at the next check interval.  If a 

response is received and a submission status has changed a message bubble with a 

notification will appear on the PC taskbar (it will disappear after 6 seconds) and the 

Checker icon will change to a star (but will change back again after a short period); 

double click the Checker icon to view the submission history.  
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Transferring Data to Tax and Corporation Tax 
 

Data can be transferred from Accounts Production to the self employment pages or 

partnership pages of a tax return in Keytime Tax or Corporation Tax.   

 

Transferring Data from Accounts Production to Tax (Individuals) 

 

Where figures have been captured in the accounts unrounded you may export rounded 

figures to Tax.  If you export unrounded figures, Tax will apply its own rounding rules, 

which are different to the mathematical rules applied to the accounts; you may find that 

the balance sheet section of the return doesn’t balance because of a rounding difference.  

To export rounded figures, click the Options menu, select Configure and click Export 

rounded figures.   

To transfer data from Keytime Accounts Production to Tax, proceed as follows: 

• Click the Export button on the main toolbar, select Keytime Tax Professional. 

• Select the correct tax year from the drop down list in the top right of the screen. 

• If you have already created the tax return for the selected year click the return and then 

click the Select Return button (bottom right). 

• If a tax return is present for the previous year, but hasn’t been year ended to create the 

return for the current year, close Accounts Production and run the year end procedure 

in Tax, this will add the return to Tax, bring forward any standing data and also add the 

new Tax job to existing client record in Client Manager.  Alternatively, if there is no 

previous year tax return add a Tax job to the existing record within Client Manager.    

• If you are not using Client Manager to actively maintain client records and you need to 

create the return, click the Create Return button (bottom left) and create your tax 

return. You will then be presented with the following screen: 
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• Use this screen to deduct disallowable expenses from the account balances; 

depreciation is always flagged as 100% disallowable. 

• Description and Box number fields show the box number and description in the pages 

in the tax return.  Page number shows the page number in return in which they appear.  

Allowable shows the amount in the account code. 

• Enter any disallowable figure in the Disallowable amounts fields; this will be deducted 

from the allowable amount.  In the case of short SE pages, the allowable minus any 

disallowable figure entered is transferred to the boxes in the SE pages.  In the case of 

full SE pages, the full allowable figure is transferred to the boxes and any disallowable 

figure is transferred to the disallowable boxes. 

• To transfer the data, click Confirm. 

• Data is transferred to the tax return and also to the Data Entry screens within Tax.  

• Capital allowances can be added by accessing the Capital Allowance calculator within 

the tax return, either within the Self Employment Data Entry screen or by clicking the 

button on the return page itself. 

 

Transferring Data from Accounts Production to Corporation Tax 

 

Transferring data to Corporation Tax works a little differently to the method described 

above for sole traders and partnerships.  Data is transferred to the Trading and 

Professional Profits Calculator; disallowable expenses are transferred on a percentage 

basis. 

• Click Export on the main toolbar, the following screen is presented: 

 

 
 

• To export figures only select Accounts only 

• To export figures and attach PDF accounts select Figures + PDF accounts 

• To export figures and attach iXBRL accounts select Figures + iXBRL Accounts 

• To attach accounts to a return select iXBRL accounts only (used where you already 

have figures in the CT600 but just need to reattach the accounts after an 

amendment) 

• To export an SNF file (standard name format) select Standard Name Format  

 

If you choose to attach iXBRL accounts as you export, the system will run a series of 

checks to ensure all necessary tags and entries are present.  If they are not the following 

screen is presented: 
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You must resolve missing tags or incomplete entries before you can generate a valid set 

of iXBRL accounts.  To resolve the errors double click on the error message to drill down 

to the section where the error has occurred, correct the error and click Save; the error will 

disappear from the list. 

 

• Select a tax return to export to, or create a new return by clicking Create Return. 

• Click Select return, the following screen is presented: 

 

 

• Enter percentages to transfer, note that it is the percentage transferred to the tax 

return you are entering here, that is the percentage that is disallowed for tax 

purposes.  Depreciation is always 100% disallowable. 

• If you wish to adjust the total disallowed figure of a particular account manually, 

you can enter 100% to transfer the total balance on the account and then adjust it 

in the Trading and Professional Profits Calculator. 

• Once you have entered the percentages click Confirm. 

• The following data is automatically transferred to the tax return: 

 

1. Net Profits as per the Accounts – This is the profit on ordinary activities 

before taxation as shown in the profit and loss account (shown as minus if 

it is a loss) 

2. If you set up disallowable expense percentages, the percentage disallowed 

for each nominal ledger code is transferred as a separate line in the 

Disallowable Expenses tab 
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3. Bank interest received is entered into Income/deficit not assessed under 

Sch D Case 1 and in the case of bank interest received also entering into 

box 6 on the return.  

4. Non-taxable income is transferred to the Totals tab as income/deficit not 

assessed under Sch D case 1 

 

• In addition, if you choose to attach iXBRL accounts as well as exporting figures to 

the return tags for disallowable depreciation, amortisation, entertaining, 

disallowable property maintenance and legal and professional fees will be 

automatically tagged for you. 

 

Export iXBRL Accounts  

 

If you are not using Keytime Corporation Tax and need to output a set of iXBRL account 

for attachment in another application you can generate a set of tagged accounts and 

specify a location where they are to be saved.   

First, set up the Save location by clicking the Options menu, select Configure, click Set 

iXBRL save location.  Browse to a suitable location and click Save.  Each time you 

generate iXBRL accounts a set of accounts will be placed in this location. 

To generate iXBRL accounts click FRS 102 Accounts XBRL on the navigation tree.  The 

system will run a series of checks to ensure all necessary tags and entries are present.  If 

they are not the following screen is presented: 

 

  
 

You must resolve missing tags or incomplete entries before you can generate a valid set 

of iXBRL accounts.  To resolve the errors double click on the error message to drill down 

to the section where the error has occurred, correct the error and click Save; the error will 

disappear from the list. 
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Year End 
 

Running Year End 

 

There are two options at year end: 

• Bring forward balances – posts the profit or loss to the Profit b/fwd account and 

brings forward the closing balances in the balance sheet accounts. 

• Blank trial balance - posts the profit or loss for the year to the Profit b/fwd 

account and clears all accounts leaving the account codes blank for the new year.   

You may find that on occasion, Bring forward balances is disabled; this happens where 

data has been previously imported.  To enable this option, click the Options menu, select 

Configure and un-tick the option to Disable year end (b/fwd balances) when balances are 

imported. 

To run year end, click the Options menu, select Year End, select either bring forward 

balances or blank trial balance, the following screen is presented: 

 

 

The accounting period start and end dates will be incremented by one year, amend the 

dates if required and click Confirm. 

If there is a balance in the suspense account (code 9999), you will be prompted to abort 

the year end and clear this account.  You will also receive a prompt to update any un-

posted journal batches.   

The year end is now complete.  Accounting period dates can be amended by clicking 

Maintain on the main toolbar and amending the period dates in the Client tab. 

If you posted accruals & prepayments journals in the previous year and you elected to 

bring forward balances at year end, you will find reversing journals in the journal 

management screen.  These journals can be treated as any other; they can be unposted 

and amended or deleted as required. 
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Roll Back Year End 

 

A Year end can be rolled back, please note that all journals and adjustments will also be 

rolled back and cannot be re-instated.  

To roll back a year end, click the Options menu, select Roll back to previous year. 

 

Opening Archived (Year Ended) Sets of Accounts 

 

You can open previous years’ sets of accounts by going to the Open Accounts main 

screen and clicking the Archived tab.  Sets of accounts can be sorted and ordered in the 

same way as current sets of accounts.  Note that a set of archived accounts cannot be 

deleted; this ensures integrity in the data set, accounts can, however, be rolled back to 

the previous year, effectively deleting the latest set and restoring the previous years.   

You can post journals and make adjustments to archived sets of accounts, however, it is 

important to note that any changes made will not be carried forward into subsequent 

years; changes must also be carried out in future sets of accounts. Archived sets of 

accounts cannot be year ended a second time. 

Backup and Restore Data 
 

We strongly recommend you take backups of your data on a regular basis.  Keytime 

Accounts Production installs with backup and restore options, you can backup and 

restore either all sets of accounts, or an individual set of accounts.  Proceed as follows: 

Backup All Sets of Accounts 

 

• Open any set of final accounts and click the File menu, then Backup then All.  You 

will be prompted for a location in which to save your backup and a file name, 

navigate to a suitable location and enter a file name, click Save.  The backup will 

be saved as a zip file. 

Backup Individual Set of Accounts 

 

• Open the set of accounts you wish to backup, click the file menu, select Backup, 

then Company.  You will be prompted for a location in which to save your backup 

and a file name, navigate to a suitable location and enter a file name, click Save.  

The backup will be saved as a zip file. 

Restoring Data  

 

As above but rather than selecting Backup from the file menu select Restore.  You will be 

prompted for a location and file name to restore from, navigate to the backup location, 

click the backup file to restore and click Open.   

 

 


